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Moneylender Professional 2.0 Users Guide 

Congratulations!!!

You've chosen one of the easiest, most versatile loan servicing applications ever created.

Follow the QuickStart First Time User tutorial and you can have your first loan set up in about two 
minutes.

Working in a networked multi-user environment couldn't be easier since Moneylender Professional 2.0 
was built from the ground up around fast file access and efficient network use.

Print statements from the default templates, or create your own from scratch or by modifying a copy of 
an existing statement or voucher template.

For detailed explanations of the elements of the main window visit the Main Window help topic.

You are welcome to run the program as a demo to get a feel for how it works. As a demo, Moneylender 
can still work in a network environment and deliver all of its features. Review the Demo help topic for 

details about the demo.

©2006 TrailsWeb LLC - All Rights Reserved 

http://www.moneylenderprofessional.com/


Demo Mode 

Moneylender Professional will run as a demo until activated. To activate the program, click Activate 
from the File Menu. If you are not sure if the program is active, click About Moneylender from the 

Help Menu. The version number will end with "demo" if the program is not activated ("2.0.0.8demo" is 
a demo version, "2.0.0.8" is an activated version) During activation you will have the opportunity to 

purchase licenses with your credit card.

There are two handicaps in the demo which are removed when the program is activated:

All text in your portfolio is limited to three characters. You can enter as many characters as you 
like up to the full size of the text field, but only the first three characters will be saved.

Only the first three payments will be available on each loan. You can enter more payments, but 
only the first three will appear in any dialog, or be used for any computations or reports.
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Quickstart Tutorials - Overview 

There are many things you might want to do with Moneylender Professional. Below are brief 
walkthroughs for the most common tasks. Please take a moment to review any of the tutorials that 

might interest you.

You can always return to this page by clicking 
Quickstart Tutorials from the Help menu.

Using Moneylender for the First Time
If you've never used Moneylender before, read this for 

an overview of the way Moneylender handles your loans.

Setting Up Loans
Simple instructions to help walk you through setting up 

loans in Moneylender.

Moneylender Settings
Information about configuring Moneylender from the Settings dialog.

Moneylender's Main Window
A rundown of the components that make up the main screen.
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Quickstart - Using Moneylender for the First Time 

Create a New Portfolio
Everything you enter into Moneylender Professional is saved in a portfolio file. This file contains 

everything from the details of your loans, lenders and borrowers, to the specifics of the default and 
custom made statements and vouchers you'll send to your customers.

Almost everything in Moneylender's main window is grayed out until you have an open portfolio.

If this is your first time using Moneylender, click File > New Portfolio to open the New Portfolio File 
dialog. Moneylender defaults to the Moneylender Portfolios folder in your My Documents folder. It is 

recommended that you save your data there, unless you prefer another folder.

When choosing a name for your file you might want to use the name of your lending company, or 
another name that represents which loans and other records will be stored in this portfolio. You can 

have as many lenders in a single portfolio as you like.

When you click Save, the Portfolio Settings dialog will appear so you can make any customizations to 
how your data is handled. When you have configured the portfolio to suit, click OK.

Next: Setting up Loans
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Quickstart - Setting Up Loans 

Creating a New Loan
There are two ways you can open the Loan Wizard to create a new loan: 

●     clicking the New Loan ( ) icon on the toolbar
●     or clicking Loan < New Loan from the menu.

This will open the Loan Wizard to ask for all the details of your loan. As you progress through the Loan 
Wizard, you'll also be required to create a new Borrower and Lender to associate with the loan. 

Detailed instructions for the Loan Wizard, are available in the Loan Record help topic.

When you have completed the wizard your new loan will appear in the list of loans in the main window.

Next: Printing a Statement
You may also wish to Record Payments or View Reports on your loan.
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Main Window 

The main interface for Moneylender Professional 2.0 
displays a list of the loans in your portfolio and allows 

you to manage, service, and report on those loans.

There are three major components to the main 
windows, described below: The Main Menu, Toolbar, 

and List of Loans.

The Main Menu provides access to all of Moneylender's 
features. See the help topic Main Menu for details of 

every menu option.

The Toolbar provides quick access for the most 
common tasks and some additional support for 
working with the list of loans. See the help topic 

Toolbar for more about each button and what it does.

The List of Loans is the key to managing your loans. This list is the starting point for all loan servicing 
functions from recording payments to printing statements and vouchers. For details on this component 

see the List of Loans help topic.
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Main Window Toolbar 

The Toolbar in the Main Window has links to some of 
the most common tasks of interacting with 

Moneylender Professional. The New Payment, New 
Rate, and Recalculate Loan buttons are disabled 

unless exactly one loan is selected in the list of loans.

Show Closed Loans - 
Toggle this button to show and hide closed loans. 

When pushed in, closed loans are displayed in the list 
of loans. When popped out, closed loans are not shown in the main window. Changes will not take 

effect immediately, but you can press the Refresh button to reset the list of loans and display/hide the 
closed loans.

New Loan - 
Clicking this button will open a new loan in the Loan Wizard. When the wizard completes, the loan is 

added to the portfolio.

New Lender - 
This button opens a new lender record in the Lender Wizard. The lender is added to the portfolio when 

the wizard completes.

New Borrower - 
This button opens a new borrower record in the Borrower Wizard. The borrower is added to the 

portfolio when the wizard completes.

New Payment - 
Only accessible when a loan is selected in the list of loans, this will open the Payment dialog with a new 

payment record.

New Rate - 
Only accessible when a loan is selected in the list of loans, this will open the Rate dialog with a new 

rate record, allowing you to change the interest rate on the selected loan.

Recalculate Loan - 
Only accessible when a loan is selected in the list of loans, this button will re-evaluate all records 

associated with a loan, re-computing principal, interest, late fees, other fees, and balances.

Search for a Loan - 
This button does not do anything. In future releases you will have the option of showing all loans in the 
window by default, or only showing loans when a search is done. This will help reduce network and file 

overheads. In a network environment, when a portfolio exceeds a set number of loans, all network 
users will be required to search the records instead of collecting them all, preventing MLP from 
overburdening your local area network. This functionality is not currently available, however.

Search for a Borrower - 
This opens the Manage Borrowers dialog. Using the search options in this dialog lets you find a specific 

borrower within your portfolio. You can also create, edit, and delete borrowers using this dialog.

Refresh - 
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This will force a full refresh of the data in the list of loans, updating any records that have been added, 
modified or recalculated since the last time they were collected for display.
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List of Loans 

The List of Loans, outlined in red to the right, is your 
gateway to managing your portfolio. It can display 

many different attributes of each loan, customizable 
from the Moneylender Settings dialog under the 

Columns tab. Clicking a column heading in the List of 
Loans will sort the list by the values in that column.

The list of loans can highlight late loans by changing 
the background color of their rows. Closed loans have 
gray text, and loans whose primary borrower or lender 

have been deleted will appear with bold red text.

Many of Moneylender's features depend on a loan 
being selected in the list of loans. Some reports, 

toolbar buttons and most of the Loan menu options 
are only available when a loan is selected. Even though you can print statements for many loans at the 
same time, you must have a loan selected before you can open the Print Template dialog from the Loan 

menu.
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Main Menu Overview 

The main menu, found at the top of 
Moneylender's window and circled in red to the 

right, provides you with all the tools you need to 
service your loans and maintain your records.

The File menu allows you to create, open, and change portfolios, connect to networked portfolios, 
manage Moneylender's application based settings, and exit the program.

The Portfolio menu provides access to portfolio based settings, network users and publishing, template 
management, and Metro2 reporting.

The Loan menu has every option that relates to a specific loan. Most of these options are disabled 
unless a loan is selected in the list of loans. From the loan menu you can create new loans, add and 
manage payments that apply to a loan, add and manage third party fees, change and manage the 

interest rate and regular payment on a loan, change the borrowers and lender associated with a loan, 
and close or delete a loan.

The Servicing menu appears in the main menu when a loan is selected in the list of loans in the main 
window. The Servicing menu allows you to create manage and print Quick Notes. You may also print 

statements, vouchers, and notices for loans in the current portfolio.

The Other Records menu allows you to create and manage borrowers, lenders, and third party records.

The Tools menu currently does nothing. In future releases this menu will have special features like a 
simple payment calculator for easily finding out information regarding potential or existing loans.

The Reports menu provides access to loan specific reports (only when a loan is selected in the list of 
loans), and portfolio wide reports.
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File Menu 

Available from the Main Menu, the File menu allows you to create, 
open, and change portfolios, connect to networked portfolios, 
manage Moneylender's application based settings, and exit the 

program.

New Portfolio - Allows you to select a folder and file name for a 
new portfolio file. When creating a new portfolio, Moneylender will 
add the default templates, and open the Portfolio Settings dialog.

Open Portfolio - Opens a dialog to browse for portfolio (mlp) files 
on your computer.

Connect to Network Portfolio - Allows you to enter the IP 
Address, Port, and login credentials for a network accessible 

portfolio. The IP and port are readily available from the system 
tray icon in the taskbar of the host computer.

Backup Portfolio - If running a local file portfolio you may use this command to save a copy of the 
portfolio to another file on your computer.

Close Portfolio - Closes any open file or network portfolio, disconnecting any currently connected 
users.

Change Password - With a file portfolio, allows you to enter a password required to open your 
portfolio. If the password is not entered exactly, the portfolio is completely indecipherable.
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Import > Import MLP v1.0 Portfolio - Allows you to browse to an MLP1 portfolio file. Once selected, 
MLP2 will open this file and import all your MLP1 data into your new MLP2 portfolio.

Moneylender Settings - Opens the Moneylender Settings dialog, allowing control over program 
related functions like auto-backups and automatic updates from the internet.

Exit - Closes the current portfolio and exits the program.
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Moneylender Settings 

On the settings dialog (File > Moneylender Settings or F2) you can control many of Moneylender's 
behaviors.

General Tab
From the General tab you can 
turn several features on or off: 
●     The beep when MLP saves 
data to the portfolio (or 
receives the "save 
confirmation" back from a 
network host)
●     Whether or not to open the 
last opened portfolio when the 
program starts. 
●     Whether or not to use colors 
in reports for color and black 
and white printing.
●     Enable or disable the multi-
colored backgrounds in the 
main window.
●     Allow the program to check 
trailsweb.com to see if updates 
are available and download and 
install them if there are.
●     The US/UK dates allow the 
portfolio to work in a multi-regional environment. The setting is specific to the computer it's on, 
and not the portfolio it's working with.
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Columns Tab
Moneylender's main window 

can display a variety of 
attributes of your loans. Using 

the check boxes under the 
Columns tab you can enable or 
disable what is displayed in the 
main window. Because some 
columns require looking up 

another record, like the 
borrower's name, they can 
have an adverse effect on 

network performance. These 
columns are marked with an 

asterisk. 

Backup Tab
Because losing data is a major 
setback, Moneylender has an 
auto-backup feature that will 

create a duplicate of your 
portfolio on a regular interval. 
It is strongly recommended 
that you enable auto-backup 

and select a folder on a 
different physical disk from 

your main portfolio. 
Moneylender will append the 
date and time of the save to 
the end of the file name for 

easy refrence.

Only the specified number of 
copies will be made. 

Moneylender will overwrite the 
oldest backup with the newst 
one when it has reached the 

set number of copies. 



Accounting Tab-2
Depending on how you 
structure your income, 

Moneylender Professional can 
build reports using the 

payments' Date Received (for 
cash accounting) or Date 

Applied (for accrual 
accounting). Please note that 
even with Accrual Reporting, 
moneylender will only display 

amounts that have been 
received. It will not evaluate 

loans to determine the amount 
that should have been received 

and report those. In that 
sense, it is not a true accrual 

method, but does more closely 
represent the accrual basis for 
your accounts than the cash 

method.
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Portfolio Menu (Preliminary) 

Available from the Main Menu, the Portfolio menu provides access 
to portfolio based settings, network users and publishing, template 

management, and Metro2 reporting. This menu is only available 
when working directly on a file portfolio. It is disabled if this 

computer is connecting to a portfolio across the network.

Make Available on Network - When checked, the portfolio is 
available via the computer's IP address 

and chosen port number. The IP and port 
number can be found by hovering the mouse over the MLP icon in the system 

tray on the taskbar as shown to the left.

Configure Portfolio Users - This command will open the Manage Users 
dialog, allowing you to create user accounts with a user's name, login ID, 

password, and permission level.
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Portfolio Settings opens the Portfolio Settings dialog, for administering portfolio-wide settings like 
currency symbol, currency and rate precision (how many decimal points to display), network and 

Metro2 settings, and the names of the custom fields associated with different record types.



Create Metro2 Report allows you to choose a lender and generates a Metro2 compliant file containing 
all records associated with that lender.



Manage Templates opens the Manage Templates dialog for creating, editing, designing, and deleting 
the templates in the current portfolio.



Network Usage displays an always-on-top window showing the current logged-in users, their IP 
address, and the last request type sent to the portfolio.

Unlock All Objects - If a loan is locked and a user is disconnected due to hardware or network failure, 
the record may be left unlocked indefinitely. Using Unlock All Objects will reset all records to the 

unlocked state. This will not interrupt edits by current users, but may create the potential for 
simultaneous modification of the same records. It is available to release a "frozen" record without 

requiring network users to log back on to the portfolio by closing and re-opening the portfolio.
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Portfolio Settings 

With a portfolio open, click Portfolio Settings from the Portfolio Menu to open the Portfolio Settings 
dialog. It will also open automatically when you create a new portfolio file.

The Metro2 tab allows you to 
turn on and off the extra dialogs 
for managing Metro2 data in the 

Loan, Lender, and Borrower 
Wizards. If you do not use 

Moneylender's Metro2 reporting 
feature, turning Metro2 off 

makes creating loans, lenders, 
and borrowers faster and easier.

If you do use Metro2 reporting, 
you may also wish to turn on 

the Secondary borrower 
reporting if many of your loans 
have more than one borrower 

associated with them.

The Network tab of the Portfolio 
Settings dialog is where you can 
adjust the port number that the 
portfolio is published to, enable 
anonymous access and set the 
anonymous permission level, 

and enable or disable automatic 
network publishing when the 

portfolio opens.
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The Numbers tab lets you adjust 
how many decimal places to use 

with currency amounts, and 
with interest rate amounts. The 
currency precision also affects 
the rounding that occurs when 

calculating interest.

Changing the currency symbol 
on your portfolio is as easy as 
selecting it from the Currency 
Symbol drop-down. If your 

currency is not available, you 
can select Custom and adjust 
the Character Code to display 
the correct symbol. Character 

code is the Unicode number for 
your currency.

If you choose a currency symbol 
that does not display in Verdana 

(the font used in all of 
Moneylender's dialogs), 

everywhere the program would display your symbol you'll see an empty rectangle. You can change the 
font in the text boxes in your templates to a font that does support your symbol so your customers will 
see the correct symbol even though it does not appear in Moneylender. When previewing a template 

during printing your currency character should appear correctly on the pages.

The Daily and Weekly Interest Modifier drop-down allows you to choose 1/360, 1/365, 1/366 interest 
computations. This number is only used for Daily and Weekly interest computations, monthly and other 

computations are not affected by this setting. 



The Custom Fields tab allows 
you to change the label that 

appears next to custom fields in 
wizards and other dialogs. This 
can be useful for clarifying what 
type of information you want in 
each field. Custom values can 
be embedded in templates, 

allowing you to greatly adapt 
the software to match the 

specific nature of your loans.
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Loan Menu (Preliminary) 

Available from the Main Menu, the Loan menu allows you to perform all tasks 
related to a single loan. Most of the items on this menu are not available 

unless there is a single loan selected in the list of loans.

New Loan opens the Loan Wizard with a new loan record. When the wizard 
completes, the loan will be recorded in the portfolio.

Payoff Calculator - The Payoff Calculator

Recalculate Loan - To save processor time, loans are calculated when the records are changed (such as 
adding a payment, changing the interest rate, etc.). This is usually sufficient during ordinary servicing of a 
loan. If a loan becomes delinquent or otherwise changes, it may be necessary to click Recalculate Loan 

to update the Amount Due, Amount Past Due, etc. for printing a current statement. Only the loan status is 
computed real-time based on the due date of the next payment and is not affected by the calculation 
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process.

Edit Loan opens the Loan Wizard with the currently selected loan. You can make changes to the loan in 
case you entered the wrong dates or interest structures. If you are changing the interest rate or regular 

payment during the course of a loan, use Rates > Change Rate and Regular Payment > Change 
Regular Payment from the Loan menu.

Close Loan - After a loan is repaid or sold and the appropriate payment information is noted in the 
records (for accuracy on reports) use Close Loan to mark the loan as closed and hide it on the list of 

loans. Clicking the Show Closed Loans button on the toolbar will display all open and closed loans in the 
portfolio. Clicking the Show Closed Loans button again will hide closed loans.

Delete Loan can be used to remove erroneous records from your portfolio. This will permanently remove 
the payment and other records, and they will not be reflected on reports. Do not use this to remove closed 

loans, use Close Loan instead.

Payments has two submenu items for managing the 
payments associated with the currently selected loan:
Payments > New Payment will open the payment 

dialog with a new payment record bound to the 
current loan.

Payments > Manage Payments will open the 
Manage Payments dialog, showing all payment records that apply to the currently selected loan. Payments 

may be created, edited, and deleted from this dialog.

Rates has two submenu items for managing the 
interest rate over the life of a loan:

Rates > Change Rate allows you to create a rate 
record that will set the interest rate on a loan as of a 

specific date.
Rates > Manage Rates opens the Manage Rates 

dialog for creating, editing, and deleting interest rate records.



Other Charges has three submenu items for creating 
and managing fees associated with the selected loan 

and a third party:
Other Charges > Prorated Fee Wizard is useful for 
applying a fee over a specific number of payments. If 
bi-annual payments are due in relation to a loan that 
pays monthly, for example, the Prorated Fee Wizard 

can split the payment evenly over six loan payments.
Other Charges > New One-Time Fee can be used to record a fee that applies once, such as a bounced 

check fee.
Other Charges > Manage Fees opens the Manage Associated Fees dialog for creating, editing, or 

deleting any of the fees associated with the selected loan.

Regular Payment has two submenu items for 
adjusting the regular payment (the amount due 

each payment cycle): Regular Payment > 
Change Regular Payment creates a new regular 

payment record specifying the regular payment 
amount and the date the new amount applies.
Regular Payment > Manage Regular Payments opens the Manage Regular Payment dialog for 

creating, editing, and deleting regular payment changes on a loan.

Change Borrowers opens the Borrowers dialog from the Loan Wizard, allowing you to change which 
borrowers are associated with the loan.

The Lender Menu contains two sub-menus.

Change Lender opens the Lender dialog from the 
Loan Wizard, allowing you to assign the loan to a 

different lender.

Multiple Lenders 
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Servicing Menu (Preliminary) 

Available from the Main Menu, the Servicing menu allows you to create, manage, and print Quick 
Notes. You can also preview and print templates and loans.

The Servicing Menu appears in the Main Menu when a loan is selected. Otherwise, it will not be visible.
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Quick Notes (Preliminary) 

Quick Notes contains two submenu items, New Quick Note and Manage / Print Quick Notes.

Selecting Quicknotes > New Quicknote will open the Quick Note Dialog. The Quick Note dialog 
allows you to create new Quick Notes. The loan that is currently selected in the main window will 

automatically appear in the Loan field of the Quick Notes dialog.

From the Template drop down box select the default template, which is Quick Note Letterhead. Now, 
enter a short description for the Quick Note and select a date in the Note Date drop down calender. 
Next, enter the data that you wish to appear in the Quick Note in Field 1 and Field 2. Click the Save 

button to save the Quick Note. 

Clicking the Revert button in the Quick Note Dialog will delete anything that has not been saved, and 
clicking Cancel will close the Quick Note Dialog.

You may access Quick Notes that have been saved through the Quick Notes Manager Dialog.



Quicknotes > Manage / Print Quicknotes

Selecting Quicknotes > Manage / Print Quicknotes will open the Quick Notes Manager Dialog.

Select a Quick Note that has previously been saved from within the Manage Quick Notes dialog and 
click the edit button to open and edit.

The Quick Note is now open for editing.



To print a Quick Note, select the saved file in the Quick Note Manager dialog and click the print button.

The delete button will delete a selected Quick Note and the close button will close the Quick Notes 
Manager when pressed.

Clicking New in the Quick Notes Manager Dialog will open the Quick Note Dialog which allows you to 
create a new Quick Note for the currently selected loan.
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Quick Note Letterhead Templates (Preliminary) 

Custom templates may be created by going to the Portfolio Menu in the Main Menu and selecting 
Manage Templates.

You may create a new Quick Note Letterhead by selecting Quick Note Letterhead in the main window of 
the Template Manager. After selecting the Quick Note Letterhead, click the Duplicate Template button 
on the right of the Template Manager. A new Quick Note Template will now appear in the main window 

named Quick Note Letterhead 2. Edit the template by clicking the Edit Template Info button or Edit 
Template Layout button to the right of the Template Manager.

A custom Quick Note Letterhead can also be created by clicking the New Template button in the 
Template Manager. After clicking New Template the Edit Template Layout dialog will appear.
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Statements / Printing (Preliminary) 

Statements / Printing allows you to select a template and the loans that you wish to print 
statements from.

Clicking the Preview button in the Print Template will display a preview of the document to be printed.
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Other Records Menu 

Available from the main menu, the Other Records menu allows you to 
create and manage borrowers, lenders, and third party records.

New Borrower opens the Borrower Wizard with a new borrower record. 
When the wizard is complete, the borrower will be added to the portfolio.

Manage Borrowers opens the Manage Borrowers dialog for creating, finding, editing, and deleting 
borrower records.
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New Lender opens the Lender Wizard with a new lender record. When the wizard completes the 
lender is added to the portfolio.

Manage Lenders opens the Manage Lenders dialog for creating, editing, and deleting lender records.



New Third Party opens the Third Party Wizard with a new third party record. When the wizard 
completes the third party is added to the portfolio.

Manage Third Parties opens the Manage Third Parties dialog for creating, finding, editing, and 
deleting third party records.
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The Borrower Record 

Borrower records hold information about your borrower, from the name and address to their credit 
score, and even a picture.

To create a new borrower by opening a new borrower record in the Borrower Wizard click New 
Borrower from the Other Records menu. To search, view and change all the borrowers in your 

portfolio click Manage Borrowers from the Other Records menu.
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The Lender Record 

Lenders contain data about the organization or individual who receives the payments on a loan. Lender 
records contain the mailing and physical address of the lender, the name and Payable To values, 

Metro2 account IDs, and similar contact information used to help service your loans.

To create a new lender by opening a new lender record in the Lender Wizard click New Lender from 
the Other Records menu. To view and change all the lenders in your portfolio click Manage Lenders 

from the Other Records menu.
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The Third Party Record 

Third Party records are used to manage who a third party fee should be paid to. When you charge a fee 
such as a property tax payment to a loan, the Third Party is ultimately the entity that the fee is paid to.

To create a new third party by opening a new third party record in the Third Party Wizard click New 
Third Party from the Other Records menu.

To search, view, and change the third parties in your portfolio click Manage Third Party from the 
Other Records menu.
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Tools Menu 

Available from the Main Menu, the Tools menu is intended for quick calculators and similar features 
that don't directly manipulate specific records in a portfolio.

Payment Calculator opens a simple calculator routine for computing the 
regular payment, total paid, and interest paid on a loan with a given 

interest rate and payment schedule.
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Reports Menu (Preliminary) 

Available from the Main Menu, the Reports menu allows 
you to print informational reports based on a single 

loan, or on the entire portfolio. To print a report on a 
single loan you must select the loan in the list of loans 

first.

The main difference between a report and a statement 
is that statements display only the current status of a 

loan, while reports generate numbers computed from a 
broad arrangement of records summarized and 

displayed in more complex ways. This distinction is the 
reason reports are not customizable but statements 
are. Because reports read a large number of records 

from the portfolio, especially the entire portfolio 
reports, it can take some time to generate the report, 

especially in a network environment.

Single Loan Reports

Payment Detail Reports contains four sub-menu items.

Loan Payment Detail generates a report showing the details of each payment applied to a specific 
loan.

Payment Detail with Notes is similar to the Loan Payment Detail but the font is smaller and it 
includes a column that shows the text from each payment's Note field (such as check number, etc.)

Payment Detail Without Rates.

Extended Payment Detail.

Loan Status Detail shows the status of a loan from due date to due date, and the total amount of 
payments received during that period.
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The Amortization Tables menu contains two sub-menu items.

Amortization Schedule prints the projected amortization table from open date to maturity, assuming 
only the regular payment is received each month. If the regular payment or interest rate varies over 

the life of the loan, it is reflected in the amortization schedule.

Amortization Schedule with Totals

The Third Party Fees



The Complete Accounting Report

Entire Portfolio Reports

Income Analysis shows the details of money received monthly over a selected date span. It also 
shows a breakdown of principal received and interest received.

Cash Flow shows a monthly comparison of principal amount of new loans with payments received for 
a selected date span.

Summary of Loans shows how much money was received on each loan for a specific period. The 
report is separated by lender if there is more than one lender in the portfolio.

Aging Report

Gross Receipts

Portfolio Snapshot

Loan Yields

The Multiple Lenders menu contains three sub-menu items.

Income Analysis

Cash Flow

Summary of Loans
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Help Menu 

Available from the Main Menu, the Help menu opens this help 
documentation, TrailsWeb.com, and shows the currently installed 

version numbers and serial numbers of the software.

User's Guide opens this documentation so you can get 
information on whatever you're looking for.

Quickstart Tutorials opens the User's Guide to the Welcome to 
MLP2 tutorial.

About Moneylender displays the current software version and the local and activation keys if the 
program has a license installed on your computer. The software version is used by Moneylender for 
automatic updates. Moneylender also has a product version (2.0000) which corresponds with the 

purchasing and licensing system.

TrailsWeb.com is the website for Moneylender Professional's author. We built and continue to improve 
the program and welcome any suggestions or comments you might have about the software. Also we 

can help if you are having trouble using the program or discover a bug, crash, or error.
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Loans 

Loans are the backbone of information in Moneylender Professional. Most of the information stored in a 
portfolio file is connected directly to a loan. Borrowers and Lenders are connected to multiple loans, or 
to no loan at all. Payment records, Interest Rate records, Regular Payment records, and Third Party 
Fee/Other Fee records are tied directly to a specific loan record. If the loan is deleted, the associated 

records are also deleted. The borrowers, lenders and third parties are not deleted, though.

For more information about the function and structure of each record type visit the following help 
topics:

The Loan Record
The Payment Record

The Interest Rate Record
The Regular Payment Record

The Third Party Fee / Other Fee Record

Loans are displayed in the list of loans in the main window. Clicking a loan to select it enables many of 
the options in the program. If no loan is selected in the list of loans, most of the menu options are 

disabled under the Loan menu and the Reports menu.
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The Loan Record 

Loans are composed of many pieces of information, some you enter when you create or edit the loan, 
and most is computed by Moneylender automatically. Changes to loan records are done using the loan 
wizard. The loan wizard is a series of dialogs, structured to ensure a loan is not edited in a way that 
makes it invalid. Changing the maturity date to a date before the open date of the loan, for example, 

could cause major problems when calculating the balance on the loan.

As records like payments, rates, regular payment changes and third party fees are created against a 
loan, it is automatically recalculated to incorporate this data into the balance and other computed 

values.

If you want to open the loan wizard with a new loan record (add a new loan to your portfolio), click 
New Loan from the Loan menu or click the New Loan ( ) button on the toolbar.

If you want to edit an existing loan, select it in the list of loans and click Edit Loan from the Loan 
menu or right-click the loan and click Edit Loan from the pop-up menu.

There are eleven dialogs in the loan wizard. Depending on the settings of your loan and your portfolio's 
Metro2 settings you may not see all of the screens. When Moneylender has enough data to handle your 

loan the Finish button will be available, and any subsequent screens contain support information for 
Moneylender's non-critical features.

The Loan Wizard

Account Identification
To get started, a loan needs an 
account number to be identified 

by. Enter any combination of 
letters numbers or other 

characters as the account number. 
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Principal, Interest, and 
Late Fees 

Enter the amount of the loan as 
principal. Enter the annual interest 

rate as a percentage. In some 
cases, you might be using an 

interest rate that is not annual. If 
you charge a monthly rate, 

multiply that by twelve to get the 
annual rate. For example, you 

might charge 20% of the 
outstanding balance each month. 
To properly compute this interest, 

you need to enter 240 as the 
annual interest rate.

You can enter a flat fee amount or 
a percentage of the regular 

payment as the late fee for a loan. 

Dates
When selecting dates for your loan, 

enter the first date that you 
started working on the loan as the 

Created date.

The date the loan funds, or the 
date that interest begins accruing 
should be entered in the Interest 

Applies field. If interest is 
computed on its own schedule, this 

is the basis for determining the 
interest cycle. If the loan is a 

regular fixed-term loan and the 
interest applies with the payments, 

like a mortgage, the period 
between the Interest Applies date 
and the First Payment date will be 

specially computed using the 
number of days between these 

dates as the basis for how much 
interest to assess. Thus if 45 days elapse from Interest Applies to First Payment, interest is 

assessed for 45 days, not one month. Thereafter interest is computed using the standard formula 
for the payment schedule.

The First Payment date will be used to determine what the expected payment cycle will be. If 
payments arrive on a variable schedule, this date is still used for some calculations and should be 

set to the earliest date a payment might arrive. 



Loan Type 
The type of a loan determines 

which interest calculation algorithm 
is used to figure interest. Most 

loans are Fixed Term. Auto loans, 
mortgages, and many other 

installment loans are based on the 
idea of a payment arriving on a 
regular schedule, and interest 

applying on the same schedule. 
Certain scenarios where payments 
arrive at irregular intervals can be 
handled with the Variable/Variable 
setting, and pre-computed interest 

can be handled by selecting 
Interest Up Front. In the Interest 

Up Front scenario, you cannot 
change the interest rate or the 
regular payment amount during 

the course of the loan. The timing 
of payments only affects the 

addition and repayment of late fees and third party fees. Using a negative payment amount to add 
principal to an Interest Up Front loan will not affect the amount of interest charged.

If you are charging interest on any unpaid interest (compound interest) leave the Simple Interest 
box unchecked. If you only charge interest on the principal portion of the outstanding balance, 

check the Simple Interest box. In many places, simple interest is a legal requirement. Check with 
your local regulatory agency for the laws that apply to your loans.

Payment Schedule 
In a Variable/Variable scenario, the 
number of payments is disabled, 
but the arrival frequency can still 

be set. The loan will remain in Paid 
status at all times, regardless of 
the date the last payment was 

made.

In all other scenarios, Moneylender 
requires a specific number of 
payments, arriving on a set 

schedule to properly compute the 
loan. 



Loan Maturation 
Moneylender will determine the 
date when the last payment is 
made. If you want to create a 

balloon payment scenario, 
changing the Maturation Date to an 

earlier date will produce the 
desired effect. The balloon will 

appear on the Amortization Table 
Report that applies to the loan.

Interest Schedule 
In general, interest is computed on 

the payment schedule for fixed 
term loans and may be separated 

for variable payment schedule 
loans. 



Regular Payment 
The Regular Payment amount can 

be set to a pre-set amortized 
repayment amount, an interest 

only payment, or any other 
schedule you like. 

Borrowers
Add or select the borrowers that 
are associated with this loan. The 

primary borrower typically receives 
all correspondence. 



Lender
Create or select the lender that 

collects on this loan. 

Metro2 Reporting 
Information 

If Metro2 is enabled from the 
Portfolio Settings dialog, this 

window will give you the 
opportunity to enter loan specific 

reporting values. 



Custom Information 
You may wish to enter custom 

information into the custom fields, 
or describe the collateral on the 

loan. A general notes field is 
available for other information. 

Each of these fields can be inserted 
into statements, so you may find it 

useful to record unique loan 
specific information in one of the 

custom fields for inclusion on 
statements and other 

correspondence. 
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The Payment Record 

Every payment record is associated with a single loan. Payment records hold the details of a specific payment. Some of the information you 
enter yourself, and some information is computed by Moneylender and used for creating reports and interest computations.

To record a new payment first select the loan from the list of loans in the main window. Click New Payment from the Loan menu, press 
the New Payment ( ) button on the toolbar, or right-click the loan and select New Payment from the pop-up menu to open the Payment 

Record dialog with a new payment record.

There are a few "special amounts" that cause Moneylender to handle 
a payment differently:

Use a negative amount to add principal to a loan on the date specified 
in the Date Applied field. When computing balances, Moneylender will 
recognize the negative number as a principal addition and cause that 

amount to become interest bearing along with the other unrepaid 
principal on the loan.

Use zero to defer a payment. Moneylender will make the appropriate 
change to the payment due date, and subtract the regular payment at 

the date the deferral payment is applied from the amount due.

Use a positive number to denote a payment received. Check the 
Principal Only box to force the payment to credit strictly to principal 

regardless of fees and interest unpaid on the account. If Principal Only 
is not checked, the payment will apply towards unpaid fees first, then 
any amount above the regular payment amount will be applied to any 
late fees due (managed separately from third party fees / other fees), 

then any unpaid interest assessed on the account is deducted. The 
remaining amount is credited toward the principal.
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To edit or delete the payments on a loan, select the loan in the list 
of loans and click Payments > Manage Payments from the 

Loan menu.

From this dialog you can create, edit and delete payments against 
your loan. To edit or delete a payment, you must first select a 

payment from the list.

Payments marked with a red icon have incurred a late fee because 
the date received is after the grace period.
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The Interest Rate Record 

If the interest rate on your loan changes, you can record this change by creating an Interest Rate (or 
simply Rate) record.

To record a change in the interest rate 
first select the loan in the list of loans 

and either: click Rates > Change Rate 
from the Loan menu, click the New Rate 
( ) button on the toolbar, or right-click 
the loan and select Change Interest 

Rate from the pop-up menu.

Enter the interest rate as a percentage 
(such as 14.999) and not as a decimal 

multiple like (not like .14999).

Select the date when the new interest 
rate applies to the loan.

To view, edit or delete the rate records 
that apply to a specific loan click Rates 
> Manage Rates from the Loan menu. 
This opens the Manage Rates dialog, displaying the interest rate changes made to the loan. To edit or 

delete a rate record, select it in the list and the click the corresponding button.

 

©2006 TrailsWeb LLC - All Rights Reserved 

http://www.moneylenderprofessional.com/


The Third Party Fee Record 

Designed to accommodate anything from NSF fees to property tax payments, the third party fee (also called "other fees") will apply an amount to your loan that 
remains separate from other amounts, is paid before late fees, principal, or interest, and is linked to a Third Party record that contains business contact information.

There are two ways to create third party fees on an account. You can create a single fee, or you can pro-rate a fee across multiple payments.

To create a single fee select a loan from the list of loans then click Other Fees > New One-Time Fee from the Loan 
menu. Create or select a Third Party record using the New and Existing buttons. Enter the amount of the fee, and 

select the date when the fee will be applied to the loan. By default, Moneylender will select the soonest future payment 
due date, but you may choose any due date between the first payment date and the maturation date.

If you need to track an account number with the fee you can enter it in the Account Number field. Additional 
information specific to this fee, such as an NSF transaction number, can be saved in the custom fields for future 

reference. You can change the labels of the custom fields from the Custom Fields tab of the Portfolio Settings dialog.

All fees are handled separately from the principal/interest computation and loan balance. If you wish to add interest 
bearing principal to a loan enter a negative payment as described in the help topic The Payment Record.

To create a sequence of pro-rated fees click Other Charges > 
Prorated Fee Wizard from the Loan menu. Create or select the Third 
Party to associate with the fees using the New and Existing buttons. 

Enter the total amount to pro-rate and select Prorated over X payments 
and set the number of payments. For example entering six on a 

monthly payment loan will apply the Total amount evenly over six 
months. Select the start date for the fees, if you choose a date that 

would cause fees to apply after the loan's maturation date, you will be 
asked to change your selections. By default, Moneylender selects the 
next future payment due date. Thus, selecting the default date would apply the fees to the next six monthly payments.

If there is an account number associated with these fees enter it in the Account Number field.

Click Apply Fee to create the pro rated records. When managing fees on a loan, fees created with the prorated fee 
wizard display a (1/X), (2/X) indicator to show that it is part of a sequence.

To view, edit and delete fees applied to a loan, first select the loan in the list of loans and click Other Charges > 
Manage Fees from the Loan menu. This opens the Manage Associated Fees dialog, displaying all fees applied to the 

selected loan.
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To edit or delete a fee, select it in the list then click the corresponding button.
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The Regular Payment Record 

Regular Payment records allow you to change the regular 
payment of a loan during the course of loan servicing. The 
initial regular payment amount set on a loan is contained 

in the loan record itself and entered during the loan 
wizard. Any time between the First Payment Date and the 
Maturation Date of the loan, you can adjust the regular 

payment amount (except with pre-computed Interest Up 
Front loans).

To create a new regular payment record click Regular 
Payment > Change Regular Payment from the Loan 

menu, or right-click your loan and click Change Regular 
Payment from the pop-up menu.

Enter the new amount of the payment, and the date when 
this amount goes into effect.

To view, edit or delete the regular payment records 
associated with a specific loan, first select the loan by 

clicking it in the list of loans. Then click Regular Payment 
> Manage Regular Payments from the Loan menu. This 

will open the Manage Regular Payment dialog. Select a 
record from the list to edit or delete it.
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Late Fees 

A late fee is applied to a loan when the Date Received is after the Grace Period. The number of days in 
the grace period can be set from the Numbers tab of the Moneylender Settings dialog.

Late fees are handled automatically and can not be added or removed. If you need to eliminate or 
create a late fee, you can adjust the Date Received on a payment record so that it falls within or 

beyond the grace period.

When payments are applied to late fees, only the amount above the regular payment is applied. If the 
regular payment is $100 and there are $15 in late fees on the account, a $100 payment will not be 

applied towards late fees, but a $125 payment will repay the late fees in full and the remaining $110 
will credit towards repaying the principal and interest.

Any third party fees are deducted from the payment before late fees, interest, or principal.
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Sharing Data on a Network 

Moneylender Professional has a highly optimized network interface for allowing multiple users to 
connect to a single portfolio.

Before opening the portfolio up to the network, you may wish to review the settings in the Portfolio 
Settings dialog under the Network tab.

The suggested network environment for operating Moneylender Professional is a 100mbps switched 
network or faster. A 10mbps network is usable for portfolios with a small number of loans. If you have 
more than ten or twenty loans, it is strongly recommended that you use at least a 100mbps network.

Click Make Available on Network on the Portfolio Menu to open the selected 
port and allow users to connect to your portfolio. The Moneylender Icon 

appears in the system tray on your taskbar when the portfolio is available to 
network users. If you need to quickly find the IP and Port of your portfolio to 

give to a colleague so they can connect, hovering the mouse over this icon will 
display the needed information.

Creating User Accounts When a user logs in they might log in anonymously if you've enabled 
anonymous access from the Portfolio Settings dialog. In most cases, though, you'll want each of your 

users to enter a login ID and password that only you and they know. Click Configure Portfolio Users 
from the Portfolio Menu to open the Manage Users dialog. From there you can create, edit and delete 

the accounts that allow different permission levels to your data.

To see who is connected to your 
portfolio, click Network Usage 
from the Portfolio Menu to open 
the Network Usage dialog. This 
shows a list of all the Users that 
are currently logged in, their IP 

addresses, permission levels, and 
the last network request received 
from them. The last Request will 

typically say Request during 
normal usage, but may say 
Request Many, Request Full, 
CheckLock, etc. This window 

updates itself every second and 
remains on top of other windows.

If a record is locked but no user 
is actually editing the record, it was probably left open when a user disconnected from the portfolio 
without finishing whatever update they were working on. Selecting Unlock All Objects from the 

Portfolio Menu will reset all locks to correct this state without having to close the portfolio and 
disconnect all connected users. If a record is being edited when the locks are reset, it creates the 
possibility for that record to be modified concurrently by another user, but the probability of that 

happening is generally small.
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Network Users 

To manage the users allowed to access your 
portfolio through a network click Configure 
Portfolio Users from the Portfolio Menu. 
This opens the Manage Users dialog where 

you can create, edit and delete users.

Click New to create a User, or click a user 
from the list on the left side of the dialog 
and click Edit to open the Edit User dialog 
(pictured below). Enter your user's Full 

Name in the User Name field, and enter a 
shorter login ID in the LoginID field. The 

LoginID and Password must be entered by 
the user when they connect to your portfolio. 

If a user forgets their password, you can 
open their account and click the Show button next to the password to display it as regular text.

Select the appropriate permission level from the drop-
down. If you have additional information you'd like to 

store about users, you can use the Custom fields.
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Network Permission 

Changing the portfolio settings, managing network users, creating Metro2 reports and managing 
templates are not allowed across the network, regardless of login permission. Generally this is for 
security and because some objects, especially template objects, are much larger than loan and 

payment records. Using the template designer, for example, in a network environment would be a very 
bandwidth intensive operation.

Moneylender regulates access to the data in your portfolio using five permission levels:

 

  Read-  
  Only  

  Normal    Normal    Advanced  

  View Loans yes yes yes

  Edit Loans no yes yes

  Initiate Loan Recalculation no yes yes

  Change Reg. Payments or Interest Rates no yes yes

  View Payments no yes yes

  Add Payments no yes yes

  Change/Delete Payments no yes yes

  View Borrowers yes yes yes

  Create/Change Borrowers no yes yes

Delete Borrowers no no yes

View Lenders yes yes yes

Create/Change Lenders no yes yes

Delete Lenders no no yes

View Loan Based Reports yes yes yes

View Portfolio Based Reports no no yes

Print Templates yes yes yes
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Working with Templates 

Templates are a powerful feature for customizing and formatting the correspondence you send to your 
borrowers about their loans.

Templates are stored directly in the portfolio file. When a new portfolio is created the default templates 
are copied into the new portfolio where they can be changed independently from the original defaults. 

Templates can also be copied to and from portfolio files from the Manage Templates dialog.

To open the Manage Templates dialog, select Portfolio > Manage Templates from the Main Menu.

From the Manage Templates dialog, you can create new templates or duplicate existing ones, modify 
their layouts, and copy them to and from other portfolio files. The Manage Templates dialog opens two 
other windows as needed: the Edit Template Information dialog for managing the name, description, 

size, paper type and focus of a template; and the Template Designer dialog for managing the layout of 
a template.

Selecting the Right Template Focus
Templates have two types, set by the Template Focus dropdown in the Edit Template Information 

dialog: Individual Payments and Individual Loans.

Individual Payments will create a voucher printing scenario. The date range for the vouchers can be 
selected from the Print Templates dialog before printing.

Individual Loans will create a statement/general correspondence scenario.

There are two differences, one is that Individual Payments templates can print many templates for a 
single loan at one time while Individual Loans templates can only be printed once for each loan at a 
time. The second is that some fields report different values depending on which type of template is 

printing. Individual Loans templates always display the current information associated with a loan. With 
an Individual Payments template the folowing tags differ as described:

<LoanCurrentRate> - Displays the interest rate as of the date of the voucher's specific payment due 
date.

<LoanRegularPayment> - Displays the regular payment as of the date of the voucher's specific 
payment due date.

<LoanTodaysOtherFees> - Displays the fees assessed to the loan for the period between the previous 
payment's due date and the voucher's payment's due date, including the due date of the current 

payment.
<LoanAmountDue> - Displays the regular payment plus any other fees as they are described above.

<LoanNextPaymentDate> - Displays the due date for the voucher's specific payment.
<LoanNextPaymentNumber> - Displays the payment number for the voucher's specific payment.

All other fields are identical.

Structure of a Template
Templates consist of a single Template record and any number of TemplateObject records associated 

with the Template records.
Template Objects come in four forms: Text Box, Long Text Box, Shape and Image.

Common traits of all template objects include position and size, color, name, and Z-Order. The 
position (Left and Top) is the distance from the upper left corner of the template's page to the upper 

left corner of the template object. Width and height determine the size in inches of the template object. 
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The name of the template object is useful for identifying the object from the list on the left side of the 
Template Designer dialog. The Color determines the color of the text in Text Boxes and Long Text 
Boxes, and the color of the line or fill in Shape objects. changing the color has no effect on Image 

objects.

Z-Order is used to determine which objects are on top of other objects. A number from 1 to 100, this 
setting represents layers on top of each other. Objects are drawn in order of Z-Order and Name. If a 
solid-fill rectangle were placed in the same location as a text box, the rectangle might be drawn over 
the text box. Setting the text box's Z-Order to any number higher than the shape's Z-Order would 

ensure the text always appeared on top of the rectangle.

Text Boxes are useful for smaller amounts of text. They can contain up to 250 characters. Long Text 
Boxes are the same as text boxes but can hold up to 10,000 characters. Because a long text box 
object is much larger than a text box object, using text boxes wherever practical can significantly 

reduce the space needed in a portfolio file and improve printing times across a network. Try to use long 
text boxes only when the extra space is necessary.

Text Boxes and Long Text Boxes (referred to collectively as text boxes below) have an associated 
font which may be bold or italic and of any size. Each text box stores its font settings independently so 
they may be changed individually. The font color of the text is availble from the Color option of the Edit 
Template Object dialog. An optional .01 inch border of a selectable color can be added around the text 

box, and a background fill may also be selected.

"Special Values" may be inserted into the text and always appear within <> signs. Clicking the 
<<Insert Value>> button in the Edit Template Object dialog displays the list of all recognized tags that 
may be added to a text object. When the statements are printed, the tags are replaced with the values 

from the corresponding Loans, Borrowers, and Lenders.

Shapes can be used to add graphical formatting to a template. A shape object can be either a line, 
rectangle, oval, or rounded rectangle. The line thickness may be set, or the shape can be filled 

completely.

Images allow you to put an image onto a statement. The image itself is stored within the portfolio file 
and need not remain on a computer's hard drive after adding it to a template. Template Images are 

very large objects and can quickly increase the total size of a portfolio if used too frequently. When an 
image is added as a template object it is refomatted into Moneylender's native image format. The 

image will be streched or shunk to match the width and height specified in the template object. If an 
Image object is given the name <CompanyLogo> the image is replaced with the logo on file for the 

Lender associated with the current statement. Naming an Image <Borrower1Picture> will replace the 
image with the picture on record for the primary borrower associated with the current statement.
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Manage Templates 

Selecting Portfolio > Manage Templates from the Main 
Menu opens the Manage Templates dialog. (Note: You 

cannot manage templates through a network.)

From this dialog you can Create, Edit, Design, Duplicate, 
Delete, Import and Export templates.

Edit Template Info, Edit Template Layout, Duplicate 
Template and Delete Template are only available when a 

template is selected in the list on the left side of the dialog.

Clicking New or Edit Info will open the Edit Template Information dialog where you can manage the 
name, description, type, and size of your templates.

Clicking Edit Layout will open the Template Designer where you can create and modify the appearance 
and content of your template.

Clicking Duplicate will create a copy of the selected template.

Import Templates does nothing, but will allow you to open another portfolio, select templates from that 
portfolio, and copy them into your original portfolio.

Export Selected Templates allows you to browse to another portfolio file, and inserts the selected 
templates into the other portfolio. By holding Shift while clicking on templates in the list you can select 
multiple consecutive templates, and by holding control while clicking on templates in the list, you can 

select multiple non-consecutive templates to export.
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Edit Template Information 

The Edit Template Information 
dialog allows control over the name, 

description, size and type of a 
template.

The Title and Description are 
displayed in the Manage Templates 
dialog to easily identify a template. 
The name is also displayed on the 

Print Template dialog when 
selecting a template to print.

The size of the template itself may 
be adjusted. If Printed On is set to 

Custom, one template will be 
printed per page, and the paper 

type will be set to the same size as 
the template. If set to Letter or 

Legal size, Moneylender will 
automatically print as many as will 

fit on the page. This number is 
displayed as Documents Per Sheet 
under the Printed On drop-down.

The Template Focus drop-down determines whether the template behaves like a statement or a 
voucher. Individual Payments indicates voucher type, and Individual Loans indicates statement type. 

Details about the difference are available under the heading "Selecting the Right Template Focus" 
under the Templates help topic.
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Template Designer 

The Template Designer is a sophisticated tool for 
creating and modifying templates within your 

portfolio file.

There are four types of template objects, described 
in more detail under the heading "Structure of a 

Template" under the Templates help topic.

The three components of the template designer 
are the Canvas, the Object List, and the Toolbar.

The Canvas
The Canvas represents a piece of paper with the 
same dimensions as your template. (You can set 

the size of the template in the Edit Template 
Information dialog.) Everything that appears on 
the canvas appears as it would when printed on 

paper. Click on a template object on the canvas to 
select it. A selected object is highlighted by a 
dashed green line around it's border, and the 
corresponding entry in the Object List is also 

highlighted. Right-click an object to open it's corresponding Edit Template Object dialog. Click and 
Drag an object to reposition it on the canvas. Click and Drag the Grey Box in the bottom, right 

corner of a highlighted object to adjust its size.

The Object List
The Object list shows all template objects associated with the current template. If an object is 

underneath another object and cannot be selected using the canvas, you can select it by clicking its 
name in the Object List. Click an object in the list to select it. Double-click an object to open it in the 
Edit Template Object dialog. Each object type has its own icon in the Object List:  for Images,  for 

Long Text Boxes,  for Shapes, and  for Text Boxes.

The Toolbar
The Toolbar allows you to create new template objects, and manage the existing ones.

The first four buttons on the toolbar can be toggled on and off one at a time. When depressed, clicking 
on the canvas, or clicking and dragging on the canvas will create a new Template Object. Depressing 
the  icon creates a new Text Box, the  icon creates a new Long Text Box, the  icon creates a new 

Shape, and  icon creates a new Image. Click the canvas to create the object at the position you 
clicked. Click and Drag to create the object with the position and size that match the box created 

during the drag motion.

The  icon will display the Object List when depressed, or hide the object list when normal.

The , , ,  and  icons indicate the current zoom level. Use the drop-down menu to change the 
current zoom level.

The  icon opens the Edit Template Object dialog with the currently selected template object. The  
icon deletes the currently selected template object.
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To place a new template object on your template,
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Edit Template Object 

The Edit Template Object dialog allows you to control the specific properties of each Template object. 
This dialog has four forms, corresponding with the four kinds of template object.

The Text Box and Long Text Box 
appear identical in the Edit Template 
Object dialog, except that you can 

enter 10,000 characters of text when 
using a Long Text Box object and only 
250 characters of text when using a 

Text Box object.

Click Change Font to select the face, 
size, and bold or italic options. 

Checking Fill Background or Draw 
Border will add those effects to the 

Text Box object. Click the color boxes 
to the right of these check boxes to 

change their colors.

Type any text you would like to 
appear in the large box labeled Text:. 
Clicking <<Insert Value>> opens a 

dialog displaying the list of all 
available tags for adding values from 

your records into the text. When 
printing a template, these tags are replaced with the actual values from your records. In most cases, a 

description accompanies the tag, providing more information about the values each tag represents.

The Shape object has a very simple 
interface. Use the Color to set the 

color of the line or fill. Select the type 
of shape from the drop-down list. If 

Solid Fill is checked, the selected 
shape will appear as a solid color on 

your template. If Solid Fill is not 
checked, you can adjust the thickness 

of the outline of the selected shape.
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The Image Object also has a simple 
interface in the Edit Template Object 

dialog. Click the Image button to 
browse your computer for the image 
you want to place on your template. 

When imported the image will be 
resized and the colors will be 

adjusted. The Image will be stretched 
to match the size described in the Edit 

Template Object dialog. Thus, the 
relatively square image in the dialog 
on the right, when set to 2.50 x 0.75 

appears like a flattened rectangle:

As described under the Templates 
help topic, setting the name of an 

Image Object to <CompanyLogo> will 
replace the image with the Lender's logo at print time, and setting the name to <Borrower1Picture> 

will replace the image with the primary Borrower's picture at print time.
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Printing Templates 

By selecting a loan in the list of loans and choosing 
Statements / Printing from the Loan Menu you 

can open the Print Template dialog.

The top drop-down contains the names of the 
templates in your portfolio file, the second drop-

down has options for selecting which loans to print.

If an Individual Payments (voucher) template is 
selected in the top drop-down, you may choose 

either the current loan or all open loans from the 
second drop-down and the date range entered will 
be used to determine which payments are printed. 

If an Individual Loans (statement) template is 
selected, you have a broader range of options for 
selecting loans, based on the dates the loans are 

due, and the date range can be used to select 
loans due within a specific range.

Click Preview to see the results of merging the loan data into the template. Clicking the print button 
from the preview dialog will immediately send the document to the default printer with the default 

settings. Clicking Print on the Print Template dialog opens the Printer Settings dialog where you can 
select a different printer, paper source, etc. When you have finished printing templates, click Done to 

close the dialog. 
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